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Introductions

e Take 5 Minutes

 Turn to a Person Near You

* Introduce Yourself

* Business Cards

Let Rego be your guide. regoUniverSityZOZS



Agenda

* Introduction

e Configuration Basics

* Security Basics

* Installing Jaspersoft Studio
* Interface Introduction
 Data Adapter Setup

* Server Connection Setup

Let Rego be your guide.
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What Is Jaspersoft?

 Jaspersoft is a reporting software that takes information from Clarity to provide
easy to read, interactive reports for users.

* Jaspersoft reporting allows for sorting, filtering, formatting, moving/hiding
columns, string searches, zooming in/out which can be saved for future use.

 Jaspersoft comes with pre-formatted Clarity reports or can do self-service ad-hoc
reporting.

* Ad-hoc views are easy to use with drag and drop capability, crosstab views, tables
or charts.

* Reports can be published in PDF, XLS, XLSX, CSV, DOC X, RTF, ODT, ODS, or PPTX

e Reports can be run on demand, scheduled and delivered via email or embedded
within an HTML frame within Clarity.

Let Rego be your guide. regoUniversity2023



Overview - The Big Picture

{

Domain

Studio Ad-Hoc Viewer

Studio Report Ad-Hoc Report

j Dashboard l

i

Let Rego be your guide. regoUniverSity2023



Clarity Jaspersoft Overview

Jaspersoft Overview

Jaspersoft Studio Reports Ad Hoc Reports Ad Hoc Reports

Ad Hoc View Ad Hoc View | Ad Hoc View

(o; m m = \
T ¢

] Data CA PPM
Warehouse Database

Let Rego be your guide. regoUniverSity2023



Clarity Data Warehouse Overview

Data Warehouse Overview

Lightweight, drag and drop

DUsSIness user reporting

/CA Clarlty PPM \ JasperSOft Repons, capabllity
Application Ad Hoc Views & Out-of-the-box reports and

domains for Investments,
Domains

Resources, Financials, and

Timesheets

Load Data
Warehouse job

The Data Warehouse is modeled on

CA

(embedded Pentaho
Data Integration)

Data a STAR schema, with Dimensions

Clarity PPM
Database

covering the major areas in CA

Warehouse Clarity PPM and their associated
Facts

Pentaho Data Integrator is
embedded within CA Clarity PPM
The data transformation and load,
runs as a CA Clarity PPM job

regoUniversity2023
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Jaspersoft Configuration Considerations

Data Warehouse Options

* For the Jaspersoft Data Warehouse jobs to run, you must specify the Data Warehouse language and Fiscal
Time period entity. To set these values, navigate to Administration > General Settings > System Options.
Specify the language and financial period entity in the corresponding fields (this is typically English and
the name of your entity). If you do not set these values, your Load Data Warehouse jobs will fail.

Data Warehouse Options

B Languages i
English

( The Languages selected determine which localizations are included in the data warehouse. )

Entity for Fiscal Periods AHS =)

( Setting Entity for Fiscal Periods the first time will install new data warehouse time slice requests. The initial

Let Rego be your guide. regoUniversityZOZS
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Jaspersoft Configuration Considerations (Cont.)

Custom Attributes

* One of the key advantages of Jaspersoft over Business Objects is the ability to add custom attributes to
the Domain without needing to modify the universe. However, to add the custom attribute, you need to
check the new Include in the Data Warehouse box on the attribute's property. If you do not check this
box, the attribute is not added to the domain.

Object: Risk | Attribute: Escalate - Object Attribute

General

DAttribute Name  Escalate 1
MNAAARAANPPAANARAERAFNANANAAAAAAAAAAAAAAAAAAAN

VAVAVAVAVAVAVAVATE AYAAVAVAVA VA VAVAVAVAVAVAVAVAVAVAVAVAVAVAVAVAVAVAVAVAVAVAVAY

Read-Only

. Check to include the
Include in th ata < R .
\’Jare?wc?use E attribute in the warehouse.

Let Rego be your guide. regoUniversityZOZS
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Jaspersoft Configuration Considerations (Cont.)

Dynamic Query Lookup

 If including a lookup which uses a Dynamic Query, you must ensure that your query includes the column
LAST_UPDATED_DATE. If not included, the option to include in the data warehouse will be greyed out.
While not required, you should also include a filter for LANGUAGE.

. .
Example:
SELECT @SELECT:a.name:country_name@,

@SELECT:c.currency_code:currency_code®@,
@SELECT:c.currency_code [| '(' || c.currency_symbol || ')":currency_name®@,
@SELECT:c.LAST_UPDATED_DATE:LAST_UPDATED DATE®,
@SELECT:LANG.LANGUAGE_CODE:LANGUAGE_CODE®,
@SELECT:LANG.ID:LANGUAGE_ID@
FROM cmn_countries b,
cmn_captions_nls a,
cmn_currencies c,
CMN_LANGUAGES LANG
WHERE a.table_name = 'CMN_COUNTRIES'
AND @FILTER@
AND a.pk_id =b.id
AND a.language_code = @WHERE:PARAM:LANGUAGE@
AND b.currency_id =c.id
AND LANG.LANGUAGE_CODE=a.LANGUAGE_CODE

Let Rego be your guide. regoUniverSityZOZS
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Jaspersoft Automation / Jobs

Automation

There are three new jobs Jaspersoft jobs that you will need to schedule for Jaspersoft to work correctly.
They are:

* Create and Update Jaspersoft Users Job
* Load Data Warehouse Job

* Load Data Warehouse Access Rights Job

Let Rego be your guide. regoUniverSityZOZS
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Job Scheduling and Best Practices

Create and Update Jaspersoft Users Job
Create and Update Jaspersoft Users job does the following:

* Creates users in Jaspersoft for active Clarity users

* Assigns Jaspersoft roles based on granted Clarity Advanced Reporting rights

» Updates users in Jaspersoft that are inactivated or locked in Clarity

Recommended Schedule

e Optimum scheduling may depend on frequency of user changes within your environment, but nightly run
appears to be a good scheduling solution

Let Rego be your guide. regoUniversityZOZS
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Job Scheduling and Best Practices

Synchronize Jaspersoft Roles Job

* This job ensures that users of Clarity groups that have advance reporting rights and exist in Jaspersoft are
matched to the corresponding roles in Jaspersoft. This job is driven by Clarity groups.

* In Clarity, assign Advanced Reporting access rights to each report user. Without rights, those users are not
synchronized with Jaspersoft roles.

* Add the report users to groups in Clarity and verify that the groups are active.

» Select the Allow Jaspersoft Role Synchronization check box on the System Options page.

* To ensure all Clarity users exist in Jaspersoft, run the Create and Update Jaspersoft Users job before you
run the Synchronize Jaspersoft Roles job. The Clarity access group ID is the same as the role name in
Jaspersoft.

Advanced Reporting

Advanced Reporting

) ) Allow Jaspersoit Role
Ih . I
Server URL http:/iregou02.trng.regoconsulting.net:8089/reportservice

Synchronization
Organization ID  rego

Clarity PPM Database
Schema —
Data Warehouse

\n
Database Schema '+ M-DWH

Let Rego be your guide. regoUniversity2023
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Job Scheduling and Best Practices (Cont.)

Load Data Warehouse Job

The Load Data Warehouse job does the following:
* Extracts data from the Clarity database
* Transforms the extracted data into a de-normalized format

* Loads the de-normalized data into the Clarity Data Warehouse
Recommended Schedule

» Clarity support recommends running the (full) load once daily after hours, and (lite) incrementally every
hour

D El Load Data Warehouse (incremental) & Job Type: Load Data Warehouse - Job Properties

General

ElJob Name | oad Data Warehouse

Parameters

Save Parameters

Let Rego be your guide. regoUniverSityZOZS
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Job Scheduling and Best Practices (Cont.)

Load Data Warehouse Access Rights Job

The Load Data Warehouse Access Rights job does the following:

e Extracts access rights for investments and resources from the Clarity database
* Loads the extracted data into the Clarity Data Warehouse

Recommended Schedule

* Nightly — After Hours

Let Rego be your guide. regoUniverSityZOZS
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Security Basics

Security within the Jaspersoft Server can be separated into two sections:
» Jaspersoft Server Authentication/Authorization
 Clarity Authentication/Authorization

Jaspersoft Server Authentication/Authorization:
* Any user within Jaspersoft Server is given a role of “ROLE_USER” by default, which gives them basic rights to view reports.
* To develop and deploy reports to the server, a user account with a role of “REPORT_DESIGNER” is required

e Other roles, which are self-explanatory, include:
* ROLE_DOMAIN_DESIGNER
« ROLE_ADHOC_DESIGNER
* ROLE_DASHBOARD DESIGNER
* ROLE_DATASOURCE_DESIGNER
* ROLE_ADMINISTRATOR
* ROLE_SUPERUSER

Let Rego be your guide. regoUniverSityZOZS



Security Basics (Cont.

CA PPM 14.2+ Installation and Configuration will create several roles within Jaspersoft Server, which correlate to roles within Clarity,

which include:

Clarity PPM Right
Advanced Reporting - Ad Hoc
Create

Advanced Reporting -
Administer

Advanced Reporting -
Dashboard Create

Advanced Reporting - Data
Source Create

Advanced Reporting - Domain
Create

Advanced Reporting - Navigate

Advanced Reporting - Report
Create

Description

Allows resource to navigate to the Advanced Reporting page and
create Ad Hoc Views. Resource is assigned the following Jaspersoft
roles: ROLE_USER and ROLE_ADHOC_DESIGNER.

Allows resource to navigate to the Advanced Reporting page and
administer Advanced Reporting. Resource is assigned the following
Jaspersoft roles: ROLE_USER and ROLE_ADMINISTRATOR.

Allows resource to navigate to the Advanced Reporting page and
create Dashboards. Resource is assigned the following Jaspersoft roles:
ROLE_USER and ROLE_DASHBOARD_DESIGNER.

Allows resource to navigate to the Advanced Reporting page and
create Data Sources. Resource is assigned the following Jaspersoft
roles: ROLE_USER and ROLE_ DATASOURCE_DESIGNER.

Allows resource to navigate to the Advanced Reporting page and
create Domains. Resource is assigned the following Jaspersoft roles:
ROLE_USER and ROLE_DOMAIN_DESIGNER.

Allows resource to navigate to the Advanced Reporting page. Resource
is assigned Jaspersoft role as ROLE_USER.

Allows resource to navigate to the Advanced Reporting page and
create Reports. Resource is assigned the following Jaspersoft roles:
ROLE_USER and ROLE_REPORT_DESIGNER.

Let Rego be your guide.

Needed to allow Ad Hoc reporting. Note that without
the domain access user will not be able to create.

By default, this is the Clarity Administrator

To create a dashboard, users need reports to add to
the dashboard and to create those reports they will
need domain access too.

By default, this is set to the admin account. This is for
advanced users who will be creating new data sources.

By default, this is set to the admin account. This is for
advanced users who will be creating new domains.

By default, all users inherit this right but without Clarity
rights to accompany, the user cannot navigate

To create reports, users will need domain access too

regoUniversity2023
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Security Basics (Cont.)

As an example, granting project managers (via the PM group) the following rights within Clarity:
* Advanced Reporting - Ad Hoc Create

e Advanced Reporting - Dashboard Create

* Advanced Reporting — Navigate

Would show them the following when accessing advanced reporting.

Clarity PPM

4/~ Home Administration Favorites

A Lbrary View-~ Manage~ Create~

Recent Items < Visualizations
Ad Hoc Views
Create visualizations for basic reporting and analysis.
Reports
-
View and format interactive multi-page reports.
Dashboards
Combine visualizations into single-page dashboard layouts.

Let Rego be your guide. regoUniverSity2023




Security Basics — Domain Security

The following roles are in Advanced Reporting, but do not link back to Clarity groups. The Advance
Reporting administrator will have to grant these roles to every user manually in Jaspersoft.

Investment Management CSK_ROLE_INVESTMENT_MANAGEMENT
Project Management CSK_ROLE_PROJECT _MANAGEMENT
Program Management CSK_ROLE_PROGRAM_MANAGEMENT
Idea Management CSK_ROLE_IDEA_MANAGEMENT
Application Management CSK_ROLE_APPLICATION_MANAGEMENT
Custom Master Objects CSK_ROLE_CUSTOM_MASTER_OBIJECTS
Financial Management CSK_ROLE_FINANCIAL_MANAGEMENT
Resource Management CSK_ROLE_RESOURCE_MANAGEMENT
All Domains CSK_ROLE_ALL REPORTS_DOMAINS

Let Rego be your guide. regoUniverSityZOZB
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Security Basics — Domain Security

To give project managers access to all domains, add them to CSK_ROLEALL REPORTS DOMAINS. The
following table shows the difference between the two roles.

CSK_ROLE_ALL_REPORTS_DOMAINS CSK_ROLE_PROJECT_MANAGEMENT
CA PPM CA PPM
Domains . )
- -J.. Domains

Application Management —
-1

O Mt 1 YO Va4
Custom Master Objects Project Management

= 2
* 4 Financial Management
—

Idea Management
-1
* 4 Investment Management
rall

Project Management
T
*' 4 Resource Management
-

Time Management

Let Rego be your guide. regoUniverSity2023
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Security Basics — Folder Security

» Jaspersoft stores Views, Ad Hoc Reports, Dashboards, Data Sources, Domains, Input Controls, Reports,
and Templates in the Jaspersoft Repository using a folder structure. This lets you organize reports, data
sources, etc. and control access using permissions.

* Out of the Box, the Jaspersoft Repository has two primary folders:

* Public
* Houses several report templates
* Organization

* Clarity — Contains all components provided by Clarity, which includes Data Sources, Ad Hoc
Views, Dashboards, Domains, Input Controls, Reports, Resources and Templates

* Shared — Content available to multiple users
» Users — Separate folders for each user within the Jaspersoft Server
* Temp — Temporary files/reports

* Additional folders, sub-folders can be created by administrators, based on the needs of the organization

* Additional security roles can be created by administrators, based on the needs of the organization

Let Rego be your guide. regoUniversityZOZS
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Jaspersoft Studio Installation

 Jaspersoft Studio can be downloaded directly from the Broadcom support site Clarity Advanced Reporting
and Database Schema Index

* Navigate to the version of PPM that you are using and download the applicable compatible version of
Jaspersoft Studio. Download the appropriate version for your desktop platform

* The trial version should remain licensed for 30 days, after which, you’ll need to install the Clarity provided
version from your Clarity Support Download Center
* This Techdocs link also provides database schemas and ERD diagrams:
e Clarity Oracle Database Schema
e Clarity MSSQL Database Schema
* Data Warehouse Oracle Database Schema
* Data Warehouse MSSQL Database Schema
* Data Warehouse ERD Diagram

Let Rego be your guide. regoUniverSityZOZS


https://techdocs.broadcom.com/us/en/ca-enterprise-software/business-management/clarity-project-and-portfolio-management-ppm-on-premise/16-1-3/reference/clarity_ppm_advanced_reporting_and_database_schema_index.html
https://techdocs.broadcom.com/us/en/ca-enterprise-software/business-management/clarity-project-and-portfolio-management-ppm-on-premise/16-1-3/reference/clarity_ppm_advanced_reporting_and_database_schema_index.html

Jaspersoft Studio Insta

lation — 5.6.1

27

* The Studio installation should progress like
any software install for your platform, and

the defaults can be used for the base
installation:

BE

Welcome to the Jaspersoft Studio

C@ Professional 5.6.1.final Setup
(X cae N

This wizard will guide you through the installation of
Jaspersoft Studio Professional 5.6. 1.final.

% Jaspersoft Studio Professional 5.6.1.final Setup

Itis recommended that you dose all other applications
before starting Setup. This will make it possible to update
relevant system files without having to reboot your
computer.

Click Next to continue.

l Next > l l Cancel I

[=[cm

(3 Jaspersoft Studio Professional 5.6.1.final Setup

Choose Components

Choose which features of Jaspersoft Studio Professional 5.6. 1.final you want to
install.

o)

Check the components you want to install and uncheck the components you don't want to
install. Click Next to continue.

Select components to install: Jaspersoft Studio Profesq| Description
Space required: 528.7MB
< m >
< Back H Next > ‘ | Cancel

Let Rego be your guide.

_ﬂ-

(7 Jaspersoft Studio Professional 5.6.1.final Setup
License Agreement

Please review the license terms before installing Jaspersoft Studio Professional
5.6.1.final.

(v;.y

Press Page Down to see the rest of the agreement.

SUBSCRIPTION SERVICES AGREEMENT A

READ THIS AGREEMENT BEFORE INSTALLING THE SOFTWARE

THANK YOU FOR CHOOSING THIS TIBCO JASPERSOFT SOFTWARE PRODUCT. BY
CLICKING

ON THE "T AGREE™ BUTTON OR BY DOWNLOADING OR OTHERWISE INSTALLING THE
SOFTWARE, YOU ("CUSTOMER™ OR "YOU") ARE AGREEING TO THIS AGREEMENT.

IF YOU DO NOT AGREE WITH ALL OF THIS AGREEMENT, PLEASE CONTACT YOUR

SALES REPRESENTATIVE. IN THIS AGREEMENT, "TIBCO JASPERSOFT" v

If you accept the terms of the agreement, dlick I Agree to continue. You must accept the
agreement to install Jaspersoft Studio Professional 5.6. 1.final.

‘ < Back H I Agree | | Cancel |
(7 Jaspersoft Studio Professional 5.6.1.final Setup |L|i-

Choose Install Location
Choose the folder in which to install Jaspersoft Studio Professional 5.6. 1.final.

Setup will install Jaspersoft Studio Professional 5.6. 1.final in the following folder. To install in
a different folder, dlick Browse and select another folder. Click Next to continue.

Destination Folder

] Browse...

Space required: 528.7MB
Space available: 7.9GB

< Back ” Next > | ‘ Cancel

regoUniversity2023
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Jaspersoft Studio Installation —6.1.0

r B r
#J) TIBCO Jaspersoft Studio Professional 6.1.0.final Setup E‘_]éj #) TIBCO Jaspersoft Studio Professional 6.1.0.final Setup Ei_lé

* The Studio installation should progress like
. License Agreement Choose Install Location
any software install for your platform, and A e o T T
the defaults can be used for the base e S I L e R O D

SUBSCRIPTION SERVICES AGREEMENT - installation.

installation: :

READ THIS AGREEMENT BEFORE INSTALLING THE SOFTWARE

THANK YOU FOR CHOOSING THIS TIBCO JASPERSOFT SOFTWARE PRODUCT. BY
CLICKING

(ON THE T AGREE™ BUTTON OR BY DOWNLOADING OR OTHERWISE INSTALLING THE Destination Folder
SOFTWARE, YOU ("CUSTOMER™ OR "YOU") ARE AGREEING TO THIS AGREEMENT.

IF YOU DO NOT AGREE WITH ALL OF THIS AGREEMENT, PLEASE CONTACT YOUR

SALES REPRESENTATIVE. IN THIS AGREEMENT, "TIBCO JASPERSOFT" -

I If you accept the terms of the agreement, dlick I Agree to continue. You must accept the \ Space required: 565.4MB

agreement to install TIBCO Jaspersoft Studio Professional 6. 1.0.final. Space available: 21.1GB

[ 1 Agree ] [ Cancel ] < Back ][ Install ] [ Cancel ]
L 4 L ]
-
#Z) TIBCO Jaspersoft Studio Professional 6.1.0.final Setup EI_‘;\‘J 70 TIECO Jaspersoft Studio Professional 6.1.0.final Setup
e TIBC
Please wait while TIBCO Jaspersoft Studio Professional l COﬂIp.Qllﬂg the TIBCO Jaspetsolt
6.1.0.final is being installed. J aspersoft' Studio Professional 6.1.0 final Setup
Extract: com.jaspersoft.studio.hibernate3_3.2.0.GA.jar Stu d | O TIBCO Jaspersoft Studio Professional 6. 1.0.final has been
taled on your computer,
-—w- ™= J .
Extract: com.jaspersoft.studio.data.mongodb_6. 1.0.final.jar... 100% B Chck Firsh to dose this wizard

Extract: com.jaspersoft.studio.data.spotfire_6.1.0.final.jar... 100%

Extract: com.jaspersoft.studio.data.sql.ui_6.1.0.final.jar... 100%

Extract: com.jaspersoft.studio.data.sql_8.1.0.final.jar... 100%

Extract: com.jaspersoft.studio.data_6. 1.0.final.jar... 100%

Extract: com.jaspersoft.studio.doc.samples_6. 1.0.final.jar... 100%

Extract: com.jaspersoft.studio.doc_6. 1.0.final.jar... 100%

Extract: com.jaspersoft.studio.editor.jrexpressions.ui_6.1.0.final.jar... 100%

Extract: com.jaspersoft.studio.editor.jrexpressions_6.1.0.final.jar... 100%

Extract: com.jaspersoft.studio.hibernate3_3.2.0.GA.jar s

V| Run TIBCO Jaspersoft Studio Professonal 6.1.0.6nal

@
T

Let Rego be your guide. regoUniverSity2023
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Jaspersoft Studio Installation —6.2.1

° Th e St u d io i n Sta | Iat i O n S h O u I d p rog ress I i ke ',o TIBCO Jaspersoft Studio Professional 6.2.1.final Setup X | 'o TIBCO laspersoft Studio FZZ:(\:;1L::J‘I:“:)
Choose the folder n which %o install TIBCO Jaspersoft Studo

any software install for your platform, and | e s L s AL | .
the defaults can be used for the base et e T A o B o O e e
installation: sin

1f you have another vald, signed agreement with Licensor or a Licensor authorized
[reseler which spphes to the specific Licensor Software, Software Services, Mantenance
‘or Consuiting Services you are downloading, accessing or otherwise recenving, that other
agreement shall control; otherwise by using, downloading, Instaling, copying, or

‘ec:eaanc Licensor Software, Softmare Services, Mantenance or Consulting Services, or Destnation

‘b;oo:nom':ucml'mo- adjacent to the screen where these Master Terms may be ol

|

idsplayed, you hereby agree to be bound by and accept these Master Terms. These — —

Master Terms shal also apply %0 any Mantenance or Consulting Services you later gy am Fles TIBCO Uasper soft Studo Professional 6. 2. 1. finalV Browse...
jacquire from Licensor relating to the Software or Software Services, ~

1f you accept the terms of the agreement, dick [ Agree to continue. You must accept the Space requred: 602. 8

agreement %o instal TIBCO Jaspersoft Studo Professional 6.2, 1.final, Space avalable: 35,0G8

[ragee ] | conce <tok [l ] | concel

| o TIBCO Jaspersoft Studio Professional 6.2.1.final Setup o NBCO Jaspersoft Studio Professional 6.2.1.final Setup

4 .
| R e e ey TIBC2 Completing the TIBCO Jaspersoft
6.2 L&l s being Installed Jaspersoft’ Studio Professional 6.2.1.final Setup

Extract: rtjr... 59% Studio meco xa;o;sg‘xcsuoe:o&'ms.:.:.ﬁwmm

Extract: jvm horof.txt... 100% -~
Extract: logong. propertes... 100%

Extract: management-agent. jar... 100%

Extract: meta-ndex... 100%

Extract: net.properties... 100%

Extract: plugn. jar ... 100%

Extract: psfont.properties.ja... 100%

Extract: psfontj2d.propertes... 100%

Extract: resources. jar ... 100%

Extract: rt.jar... 9% v

Cick Finesh to dose ths wazard

£ Run TI8CO Jaspersoft Studo Professonal 6.2. 1. final

Let Rego be your guide. regoUniverSity2023




Jaspersoft Studio Installation —7.1.0
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* The Studio installation should progress like
any software install for your platform, and
the defaults can be used for the base
installation:

License Agreement
Please review the license terms before installing TIBCO
Jaspersoft Studio Professional 7.1.0.final.

Press Page Down to see the rest of the agreement.

END USER LICENSE AGREEMENT A

If you have another valid, signed agreement with Licensor or a Licensor authorized

reseller which applies to the specific Licensor Software, Software Services, Maintenance

or Consulting Services you are downloading, accessing or otherwise receiving, that other
agreement shall control; otherwise by using, downloading, installing, copying, or

accessing Licensor Software, Software Services, Maintenance or Consulting Services, or

by dlicking on "I accept”™ on or adjacent to the screen where these Master Terms may be
displayed, you hereby agree to be bound by and accept these Master Terms. These
Master Terms shall also apply to any Maintenance or Consulting Services you later

acquire from Licensor relating to the Software or Software Services. v

If you accept the terms of the agreement, dlick I Agree to continue. You must accept the
agreement to install TIBCO Jaspersoft Studio Professional 7.1.0.final.

I Agree Cancel

4 Installing

Please wait while TIBCO Jaspersoft Studio Professional
7.1.0.final is being installed.

Extract: complete-ant-cmd.pl

Extract: SAX-LICENSE.html... 100%

Output folder: C:\Program Files\TIBCO\Jaspersoft Studio Professional-7. 1.0.final\plu...
Extract: ant... 100%

Extract: ant.bat... 100%

Extract: ant.cmd... 100%

Extract: antRun... 100%

Extract: antRun.bat... 100%

Extract: antRun.pl... 100%

Extract: NOTICE... 100% A

Extract: antenv.cmd... 100% v

< Back Next > Cancel

Let Rego be your guide.

' Choose Install Location

Choose the folder in which to install TIBCO Jaspersoft Studio
Professional 7.1.0.final.

Setup will install TIBCO Jaspersoft Studio Professional 7.1.0.final in the following folder. To
install in a different folder, dlick Browse and select another folder. Click Install to start the
installation.

Destination Folder

Program Files\TIBCO\Jaspersoft Studio Professional-7.1.0.final Browse...

Space required: 612.3MB
Space available: 758.9GB

< Back Install Cancel

Completing the TIBCO Jaspersoft
Studio Professional Setup Wizard

Jaspersoft’
Studio

TIBCO Jaspersoft Studio Professional 7. 1.0.final has been
installed on your computer.

Click Finish to close Setup.

Run TIBCO Jaspersoft Studio Professional

< Back Finish Cancel

regoUniversity2023
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Jaspersoft Studio Installation —7.9.0

9 TIBCO Jaspersoft Studio Professional 7.9.0 Setup = X 7) TIBCO Jaspersoft Studio Professional 7.9.0 Setup = X

4

* The Studio installation should progress like
any software install for your platform, and
the defaults can be used for the base PressPage Doun o s the st of e cgreement o erent e Brow s e Aot T, ik mtal s

=nd User License Agreement installation.

I n Sta I I at I O n : If you have another valid, signed agreement with Licensor or a Licensor authorized |

reseller which applies to the specific products or services you are downloading,
accessing, or otherwise receiving, that other agreement controls; otherwise, by using,
downloading, installing, copying, or accessing Software, Maintenance, or Consulting
Services, or by dlicking on "I accept” on or adjacent to the screen where these Master -
Terms may be displayed, you hereby agree to be bound by and accept these Master Destination Folder
Terms. These Master Terms also apply to any Maintenance or Consulting Services you
later acquire from Licensor relating to the Software.

Choose Install Location

Choose the folder in which to install TIBCO Jaspersoft Studio
Professional 7.9.0.

Please review the license terms before installing TIBCO
Jaspersoft Studio Professional 7.9.0.

Browse...

If you accept the terms of the agreement, dlick I Agree to continue. You must accept the Space required: 1.1GB
agreement to install TIBCO Jaspersoft Studio Professional 7.9.0. | | Space available: 254.1GB |

1 Agree Cancel < Back Install Cancel

Z) TiBCO Jaspersoft Studio Professional 7.9.0 Setup = Z) TIBCO Jaspersoft Studio Professional 7.9.0 Setup =

4 Installing i .
Please wait while TIBCO Jaspersoft Studio Professional 7.9.01is T' Bcz Completmg the_ TIBCO Jaspe_rsoft
being installed. | aspersoft' Studio Professional Setup Wizard

Extract: bcprov-jdk150n-1.64.jar... 100% S t u d | O TIBCO Jaspersoft Studio Professional 7.9.0 has been
installed on your computer,

Click Finish to dlose Setup.

Extract: batk-ext-1.11.jar... 100%
Extract: batk-gvt-1.11.jar... 100%
Extract: batk-18n-1.11.jar... 100%
Extract: batk-parser-1.11.jar... 100%
Extract: batk-script-1.11.jar... 100%
Extract: batk-svg-dom-1.11.jar... 100%
Extract: batk-svggen-1.11.jar... 100%
Extract: batik-util-1.11.jar... 100%
Extract: batk-xml-1.11.jar... 100%

| Extract: beprov-jdk150n-1.64.jar... 100%

1]
]
J
)
T

=]

Next > Cancel < Back Cancel

3

Let Rego be your guide. regoUniverSityZOZS
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» After completion of the Studio software
installation, launch the application

* The Studio software is built on top of the

Eclipse platform, those with eclipse
experience should feel right at home

* There are 7 panels in which you’ll spend
most of your report development time:

Repository Explorer
Project Explorer
Outline

Palette

Properties

Report Design
Report State

Let Rego be your guide.
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Jaspersoft Studio Interface (Cont.)

* Repository Explorer
Used to view and create Data Adapters, connect to and browse Jaspersoft Servers
* Project Explorer
This is your project folder structure, where you will create, and maintain your various reporting projects
* Report Design
The design view will be used for development, and initial testing of your reports
e Outline
This view will give you a hierarchical view of your report, providing an easy-to-read structural view of your
report
* Palette
Drag and Drop components that can be included within your report
* Properties
Much time will be spent here tweaking individual settings of various reporting components
* Report State
During development, this view will provide error reports used for debugging

Let Rego be your guide. regoUniversityZOZS
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Jaspersoft Studio — Data Adapter

* In this exercise we’ll create a new Data Adapter, which we will connect to an existing Clarity 14.2+ Oracle
instance

* From the “Repository Explorer” right-click on Data Adapters, and select “Create Data Adapter”, then select
“Database JDBC Connection” =

a Data Adapter Wizard ] X

Data Adapter
Database JDBC Connection

Data Adapter
Database JDBC Connection

9 Data Adapter Wizard [= | o .

Data Adapters
Use SQL queries 1o get data from a databae Name: | New Data Adapter ‘ Name: l RegoUnviersity ‘
SV File JDBC Driver | org.hsqldb.jdbcDriver |V JDBC Driver ‘ tibcosoftware.jdbc.oracle.OracleDriver V‘
? Cossandra Comnection JDBC Url Mondrian (mondrian.olap4j.qudrianOIapA‘lj!I)river) ] A JDBC Url ljdbc:jaspersoft@https:‘//cppmrpt103.ondemand.ca.com/’repor‘tservice;datasourcez‘l
& Collection of JavaBesrs MongoDB (TIBCO Jaspersoft) (tibcosoftware,jdbc.mongodb.MongoDBDriver)
& Custom implementation of JRDataScurce Username | MySQL (org.gjt.mm.mysql.Driver) Username l regoudev|cppm9172 l

" = MySQL (com.mysql.jdbc.Driver)
2 E:’ft‘"“ 209¢ Conmection Password | OLAP4) (org.olap4j.driverxmla.XmlaOlap4jDriver)
JBOL Connecticn

Oracle (oracle.'dbc‘driver.OacIeDriver) _ . Attention! Passwords are saved in clear text
Empty rows Oracle (TIBCO Jaspersoft) (tibcosoftware.jdbc.oracle.OracleDriver)

P2 HBase Connection PostgreSQL (org.postgresql.Driver)

RedShift (TIBCO Jaspersoft) (tibcosoftware.jdbc.redshift.RedshiftDriver)
SQLite (file) (org.sqlite. JDBC)

SparkSQL (Simba JDBC driver) (com.simba.spark.jdbc4.Driver)

Password ‘ esscsscee ‘

2 HEase Thaft Commection

Hiernste Session

Hizernate Session Loaded By Speng SparkSQL (TIBCO Jaspersoft) (tibcosoftware,jdbe.sparksql.SparkSQLDriver)
¥ Hwve Connection Sybase (net.sourceforge.jtds.jdbc.Driver)
% IND! Data Sousce Sybase (com.sybase.jdbc4.jdbc.SybDriver)
© JSON File v Vertica (com.vertica.Driver)

Vertica (com.vertica.jdbc.Driver)
inetdae7 (com.inet.tds. TdsDriver)

Database Loq < S Database Location | Connection Properties | Driver Classpath

? Ned » Cancel

P

—_ (€)) < Bac ext > ini
@ [ <bec | IREES Concel = I csz

Let Rego be your guide. regoUniverSityZOZS
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Jaspersoft Studio — Data Adapter
* Enter the credentials appropriate to your organization e —
* Example: ty |
* JDBC Driver: =
com.jaspersoft.jdbc.driver.JasperDriver

* JDBC Url:

jdbc:jaspersoft@http://regou02.trng.regoconsulting.net
:8089/reportservice;datasource=/ca_ppm/data_sources
/CA_PPM_BEAN;pagesize=100

* Username: regodev|rego

e Password ; Fxxxk*

Database Location | Connection PropertieE Driver Classpath |

* Navigate to Driver Classpath and select the drivers that were
downloaded with your Jaspersoft Studio installation file:

Let Rego be your guide. regoUniverSityZOZS
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Jaspersoft Studio — Repository Connection

* At this stage, having connected a Data Adapter to a Clarity Database, one can begin development locally

* To validate your locally developed report against the Jaspersoft Server, you must first connect your Studio
environment to a Jaspersoft Server

* Within the “Repository Explorer” right-click on “Servers” and select “Create JasperReports Server
Connection” and name the connection appropriately

* For this session, you are supposed to use your organizations’ server credentials.

2
¢ Exa m p I e : JasperReports Server Access Configuration
Configure server connection

* URL: http://regou02.trng.regoconsulting.net:8089/reportservice/ e |
i O rga n izat i O n : rego URL & l https://cppmrpt103.ondemand.ca.com/reportservice l

Connected
* U Se r: regOd ev = UTNLEU - 1EsL O:gc::i:ation [ cppm9172 ]
[ ] PaSSWO rd : % % %k k% VvV = User I regoudev l

. Create JasperRRorts Server Connection
Adecco - Productioft

Passwor d I ooooooooo l

S
| .
-3

+ Advanced Settings

‘?’ Test Connection Einish Cancel

Let Rego be your guide. regoUniversityZOZS
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Jaspersoft Studio — Connect to On Demand

* You can connect Jasper Studio ( Jaspersoft 6.2.1_5.2.1.x or higher ) to client Clarity transactional or data
warehouse database without a VPN connection using Clarity JDBC Adapter.

Here is how you do it:
» Install the adapter:
e Exit any instance of Jasper Studio that is running.

* Create folder “drivers” at your Jaspersoft workspace location. ( Click File in Jasper Studio and select Switch
Workspace to find workspace location )

* Copy the contents of ca_jdbc_adapter_7.8.0_6.4.0.6.zip to “drivers” folder

* Contents should include clarity jdbc_adapter 7.8.0_6.4.0.6.jar, jdbc\ojdbc8-12.2.0.1.0.jar ,jdbc\postgresql-
42.2.6.jar

* Reopen the Jasper Studio
» Create a Clarity JDBC Adapter Connection:

* From the “Repository Explorer” right-click on Data Adapters, and select “Create Data Adapter”, then select
“Database JDBC Connection”

Let Rego be your guide. regoUniversityZOZS
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Jaspersoft Studio — Connect to On Demand

* Give it a meaningful Name, then select “com.jaspersoft.jdbc.driver.JasperDriver” for the JDBC Driver

* URL :
jdbc:jaspersoft@<report_service _url>/reportservice;datasource=/ca_ppm/data_sources/<bean_name>;pagesize=500

<report_service_url> is available in System Options-Advanced Reporting.
<bean_name> is CA_PPM_BEAN ( Transactional DB ) or CA_PPM_DWH_BEAN ( DWH DB)
* Username: <USERNAME>|<ORGANIZATION_ID>

Username: report developer user created in Advance Reporting. Organization Id is available in System Options-Advanced
Reporting.

* Password : report developer user password

* Click the Driver Classpath tab, Add the CA JDBC jar files . Click Test to Verify and Click Finish

T ———— |~ |

¥ Data Adapter Wizard

¥) Data Adapter Wizard

Data Adapter

Name: CA PPM DWH Development
JDBC Driver com.jaspersoft.jdbc.driver.JasperDriver

Username  jasperdevjcappml234_dev

Attention! Passwords are saved in clear text

Database Location | Connection Properties | Driver Classpath

JDBC Url jdbcijaspersoft@https://cappml234.ondemand.ca.com/reportservice;datasource:

= /ca_ppm/data_sources/CA_PPM_DWH_BEAN;pagesize=500

Data Adapter
Database JDBC Connec tion

Name: CA PPM DWH Development

Jar Files Path

CAUsers\windows\JaspersoftWorkspace\drivers\jdbc\ojdbc6-11.2.0.4 jar

C:\Users\windows\JaspersoftWorkspace\drivers\ca_jdbc_adapter_6.2.1.3.jar

tion Properties |Driver Classpath/

Database Location | Connec

Let Rego be your guide.
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Bonus — DBeaver Database
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* Now that we have Jaspersoft
Studio and the JDBC drivers
installed we can utilize drive to
connect to the Clarity Transactional
and DataWarehouse databases.

* Dbeaver Community is a free,
multi-platform database tool that
can be configured to utilize the
provide JDBC driver.

* To download navigate to
https://dbeaver.io/download/ - the
free version should be all that you
need.

* Having the ability to write and test
qgueries outside of Jaspersoft
Studio allows you to work more
efficiently.

Download

Community Edition 21.2.0

Released on August 30, 2021 (Milestones).
It is free and open source (license).
Also you can get it from the GitHub mirror.

Installer Language X
v“('-.:; : Please select a language.
)

English v

| : I Cancel

L',;’“ DBeaver Community 21.2.0 (x86_64) Setup —

Welcome to DBeaver Community
Setup

Setup will guide you through the installation of DBeaver
Community.

()Beaver

It is recommended that you close all other applications
before starting Setup. This will make it possible to update
relevant system files without having to reboot your
computer.

Click Next to continue.

Let Rego be your guide.

(%) DBeaver Community 21.2.0 (x86_64) Setup == X

License Agreement

Please review the license terms before installing DBeaver Community.

Press Page Down to see the rest of the agreement.

| PN
Apache License
Version 2.0, January 2004
http: //www.apache.org/flicenses/

TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION
1. Definitions.

“License" shall mean the terms and conditions for use, reproduction,
and distribution as defined by Sections 1 through 9 of this document. v

If you accept the terms of the agreement, dick I Agree to continue. You must accept the
agreement to install DBeaver Community.

<Back Cancel

regoUniversity2023
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Bonus — DBeaver Database

41

* Once installed navigate to Database>Driver Manager and click New
* Enter the following:

* Drivername: CAPPM

* Driver Type: Generic

* Class Name: com.jaspersoft.jdbc.driver.JasperDriver
* Next we will need to attach the JDBC drivers

* Click Add File and attach the same drivers from the Jaspersoft Studio installation.
* Once you have created the Driver you can now create the connection(s) for each environment.

* Go to Database>Driver Manager and select the new Clarity PPM connection type that we just created.

‘s DBeaver 21.2.0
File Edit Navigate Search SQL Editor Database Window Help

¢ " ‘ TsqL ~ & w ' ¢ ¥ New Database Connection
T _ . = Driver Manager
& = Database Navigator '@ Projects
= Connect
@ General Invalidate/Reconnect
Disconnect
Disconnect All

Disconnect Others
&b Tasks >

® Tools >
Context tools

Let Rego be your guide.

= Edit Driver 'Clarity Driver' O X

Settings Libraries Driver properties Advanced parameters

Driver Name: tlarity Driver

‘ com.jaspersoftjdbc.driver.JasperDriver ‘

Driver Type: = Generic v

Class Name:

URL Template: ‘ ‘

Default Port: Default Database:

[C]Embedded [| No authentication [_] Allow Empty Password
[Juse legacy JDBC instantiation

Cancel

= Edit Driver 'Clarity Driver' O X

Settings Libraries Driver properties Advanced parameters

i B:\Rego\ca_jdbc_adapter_7.1.0.3\ca_jdbc_ad

Add File
i B:\Rego\ca_jdbc_adapter_7.1.0.3\jdbc\ojdbq
# javax.xml.bind;jaxb-api:RELEASE [RELEASE] Add Folder
Add Artifact

Download/Update

Information

Delete
Classpath
< >
Driver class: ~ | |Find Class
Reset to Defaults Cancel

regoUniversity2023
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* Once you have created the Driver you can now create the connection(s) for each environment.

* Go to Database>New Connection and select the new Clarity PPM connection type that we just created.

* Use the same URL, username and password as in the Jaspersoft setup to create the connection:

‘s DBeaver 21.2.0

File Edit Navigate Search SQL Editor Database Window Help

¢ v

s & Database Navigator @ Projects

=
@ General

JsqL v B Commit %

=3

New Database Connection
= Driver Manager

Connect
Invalidate/Reconnect
Disconnect
Disconnect All
Disconnect Others
Commit

Rollback

Transaction mode
Transaction log
Pending transactions
Tasks

Tools

Context tools

Ctrl+Alt+Shift+K
Ctrl+Alt+Shift+R

Alt+

>

‘%) Connect to a database

Select your database

Create new database connection. Find your database driver in the list below.

Type part of database/driver name to filter

S Al

S Popular

“saL

“ Nosal

= Analytical
 Timeseries

“ Embedded

e Hadoop / BigData
 Full-text search
 Graph databases

SQL Server

Test Connection ...

Clarity Driver

Apache Drill

ClickHouse Cloudera

J

SQlite DB2 LUW

B

Apache Hive ~ Apache Ignite

DuckDB

/)

CockroachDB CrateDB

Impala

DN

< Back

i
MariaDB

MariaDB

4

Apache
Phoenix

i
g

My
MySQL

Spoﬁ(l S

Apache Spark

¢
) 4

CUBRID

Sort by: O Title (®) Score

A
S0DBC ORACLE ( !g i

ODBC Oracle PostgreSQ
Athena Azure SQL Cache
Server

Data Virtuality DB2 DB2 LUW (C
iSeries/AS 400 8x)

&

EDB Exasol

POSTGRES

Finish Cancel

Let Rego be your guide.

(&) Connect to a database
Generic JDBC Connection Settings

Claity Driver connection settings

Main  Driver properties SSH  Proxy

General

w ~

10BC URL:|

Authentication (Database Native)

Usemname:

Password: [V Save password locally

® You can use variables in connection parameters

Driver name: Clrity Driver

Test Connection

Connection details (name, type, )

Edit Driver Settings

< Back Next > inish Cancel

regoUniversity2023
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Part Il: Agenda

Creating a Report
* Project Creation

* Report Creation
* Query Setup
* Field Creation
Basic Report Objects
v’ Static Text
v' Text Field
v" Frames
v Shapes
v Breaks
Report Preview

rego
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Part Il
Project Creation

v’ Creating your first project
v Add fields to your Report

v’ Preview your Report

A
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Creating

he Project
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* You should now have an installation of Jaspersoft Studio, a Data Adapter connected to a Clarity database,
and a Jaspersoft Server connection for deployment

 Start by creating a new Project, within the “Project Explorer” tab, by clicking on “File -> New -> Other”, then
select “JasperReports Project” and click “Next”

**Be careful not to create a new generic Java project

 Name your project appropriately, such as “Training Project - <Initials>”", to avoid conflicts during deployment

¥2 TIBCO Jaspersoft® Studio Professional
File Edit Navigate Project Window Help

New Alt+Shift+N > & Jasper Report

Open File...
C. Open Projects from File System...
Recent Files

Close

Ctrl+W

Z Style Template File
% Data Adapter

> [ Project...
9 Other... Ctrl+N

/’) New

Select a wizard

Create a JasperReports project

Wizards:

O

X

type filter text

v = Jaspersoft Studio
© Chart Themes
# Custom Visualization Component
% Data Adapter
f# Functions Library
i Jasper Report
A JasperReports Fonts Extension
i JasperReports |0 Report Execution Context
& JasperReports Project
JasperReports Samples
4 Plug-in Data Adapter
n Ciln

¥ Chda Tamanla
[[] show All Wizards.

Let Rego be your guide.

,’) New Jasper Project Wizard
|

{
New JasperReports Project

Create a new JasperReports project

O X

Name | Project Status Repord

® < Back Next >

inish Cancel

regoUniversity2023
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Creating The Project

* Since the Jaspersoft project has been created, you can now create the report (Jrxml file).

 Start by navigating to the Project Explorer. Right click the Project Folder you just created and select New ->
Jasper Report

* Select the template you want the report to be based on. Templates determine Size and default items and
formatting based on the one chosen. Click Next.

e Select the project folder you just created. Click Next.

* Next select the Data Adapter to be used to test this report with.

* Click Finish.
New > 7 Project...
Go Into ~ Jasper Report
Show In Alt+Shift+w > £ Style Template File
= Data Adapter
- Copy Ctrl+C
“ Copy Qualified Name File
= Paste Ctrl+V & Folder
% Delete Delete [ Other.. Ctrl+N

Let Rego be your guide. regoUniversityZOZS
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Data Setup

The query can be setup in two ways:
1. Create a query using SQL to get the data we need to put into the report.
2. Create a domain to get the data we need to put into the report. (This is covered in the advanced)

Navigate to the Outline tab.

Right click on the Report (This will be the name of the jrxml).

* This will bring up the Dataset and Query interface.

#2 Dataset and Query Dialog O X
= Carity ¥ =
Query Java Bean
v e BIank_A4 Language | sql e Read Fields
= GSMUSER ~All®1
7 St)/|e Undo % MASTER
< NIKU_DEV
-/ Parar Redo % NIKU_TEST (CURRENT)
= OUTLN
- = : & PERFSTAT
Field © Show Properties e
| £ PPM_DWH_TEST
“ Sort = Dataset and Query & PPM_JASPERSOFT_DEV
fx Varla = (..I'eate broup = EF:’\’ATJ_A_S.P“EIRSOFT‘TEST Vv | |Texts|Outline| Diagram
= SCFI p 4 Create Dataset Field Name Class Type Description Tim¢ = Add
Edit
= Title csVv Tags > Delete
=t Pane Heaner < >| W |
c

Let Rego be your guide. regoUniverSityZOZS
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Field Creation

Now that we have the Dataset and Query interface up, we can input our query.

Once we have put our query in the dialogue, click the Read Fields button.
* Note: This will only read fields if you have access to the database.

Steps to manually create fields.
1. Click the Add button.
2. Name the field the exact alias name as in the query. (This includes caps)
3. Change the Class Type to the appropriate data type.

Data Types
e Java.lang.String (All Strings)
e Java.math.BigDecimal (Numbers with decimals) : Convert this to java.lang.Double
» Java.lang.Boolean (Boolean type)
 Java.util.collection (Use this for multi value field separated via commas)
 Java.util.date (Date Type)
e Java.lang.integer (Numbers without decimals)

Let Rego be your guide. regoUniversityZOZS
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Let Rego be your guide.

Title: First section of the
report.

Page Header: Repeated on
each page at the top.

Column Header: The header
for the Detail below.

Detail: The data for each
row in your query.

Column Footer: The footer
for the Detail above.

Page Footer: Repeated on
each page on the bottom.

Summary: The last section
of the report.

regoUniversity2023
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Basic Report Objects

* To add objects to your report, navigate to the Outline tab and check the elements in the Palette tab.

“Image - Image element
Break - Broak element
Rectangle - Rectangle element
Ellipse - Ellipse element
Line - Line element

“ Generic - Geners < element
Frame - Frame element
Subreport - Subreport element

“Barcode - Barcode element
List - List element

® Chart - Chant element
Crosstab - Crosstab element

* The following objec“’Eﬁsv‘é“FémévaiIabIe.
 Static Text: Object which allows you to put permanent text on the report.

. T((ejxt Field: Object which lets you utilize, fields, parameters, and Java functions with the expression
editor.

* Image: Object which lets you reference an image stored in the Repository.
* Break: Object which creates a new page for the contents put after.
* Rectangle: Object which lets you create a clip art of a rectangle.

* Frame: Object which can size itself to the contents inside. It also allows to keep grouping objects in a
report to move together.

Let Rego be your guide. regoUniversityZOZS
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Basic Report Objects: Static Text

* The static Text Object allows you to put permanent unchanging text on a report. In our example, let's add
the Static Text object into the Title Band.

Static Text

* Exercise: Add Static Text to your report.

Let Rego be your guide. regoUniverSityZOZS
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ext Field

* The Text Field is a dynamic field you can place on a report. The text field is unique in that it lets the user
pull in fields, parameters, and implement Java functions to these values using an expression editor.

* Exercise: Add a text field that modifies the “Is Active” field to be a yes or no versus a 1 or O.

)

Expression Editor

Edit the JasperReports expression that returns the expected type.

SF{IS_ACTIVE}.equals(1) ? "Yes":"Nc"|

%F Parameters A || type filter text

=

& Fields PROJECT_DB_ID Field Integer A
/% Variables

PROJECT_NAME Field String
PROJECT_ID Field String
PROJECT_MANAGER_DB_ID

%, Resources
v Built-in Functions

Diakie & e PROJECT_MANAGER_USER |
Logical PROJECT_MANAGER Field St
Message Bundl REPORT_NAME Field String
Numeric / Matl
< >
Text v
< > 24 £1

+ Value Class (backward compatibility only)

Let Rego be your guide.

type filter text

bitCount( int) int A
byteValue() byte
compare( int, int) int
compareTo( Integer ) int
compareTo( Object ) int
compareUnsigned( int, int ) int
decode( String ) Intege
divideUnsigned( int, int ) int
doubleValue() double

eanalel Nhiert ) honlean

regoUniversity2023
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Basic Report Objects: Shapes

In Jaspersoft studio there are 3 shapes that can be added to a report.
* Line
e Rectangle
* Ellipse

Each shape can have its size, direction, and color changed via the appearance tab.

Exercise: Add a line to separate two area of a report.

Exercise: Add a rectangle to the report and change the color.

Exercise: Add an ellipse to the report and change the size.

Let Rego be your guide. regoUniverSity2023
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Basic Report Objects: Frames

» A frame allows the user to group objects in a single area. Utilizing frames in your report can keep your
report organized and clean.

* A frame can be configured to auto size based on the size of its content. This allows the user to not worry
about the text fields over stretching the section in which they are present.

* Example below. If the Objective section has more text than the Accomplishment section, they will remain
the same size. This is due to both sections are in the same Frame.

$R{ProjectObmctivekay) $R(XeyAccompishments Key)
$F{OBJECTIVE} $F{KEY_ACCOMPUSHMENTS)

SR{SRUpcateKey} SR{UpcomingActiviies Key}
$F{SR_REPORT_UPDATE} $FUPCOMING ACTIVITIES)

* Exercise: Create a frame to hold the descriptions and a few field below that section. These fields should
auto position to be right below the large text area regardless of how big or small it is.

Let Rego be your guide. regoUniversityZOZS



56

Basic Report Objects: Breaks

* A break allows the user to separate two
sections to always be on the next page or

Section 1

column.

* Use a break to separate sections in a
report manually instead of requiring the Break
data to do so.

* Exercise: Separate a section on your
report to always be on the next page Section 2
regardless of the amount of data.

Let Rego be your guide. regoUniverSityZOZS
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Basic Report Objects: Table

A Table element allows you to organize information in rows and columns. It is extremely powerful
component that can replace the usage of sub reports in many situations.

Here is how you add and configure the Table:
* Drag the Table element from Basic element Palette.
* You can either create a table using a new dataset or an existing dataset.

* Create a table using new dataset provides yrou the option of seIectinF Dataset name, Data source to use,
Put in the required query, Connection type, Table columns and Table layout.

’) Table Waard

¥) Dataset

Dataset ﬂ Dataset w - -lglélﬂ 0 Tovie Woa T— R R X ]
Pleate select ce budd » dutaset that wil be used fer this componert Dataset Layeut
Data Source Ple
Create a new dataset, please select a unique dataset name,| .
® Create 2 Table using a new dataset Select a Data Source and design the query.
Create » Table uting an existing detaset Dataset name: Grid Dataset : Tatie Header [] Cotomn Header []
= Data Adapter CA PPM DWH Development - Database JDBC Connection v] o M oest 1
= NIKU - 31 P Uit storrated detad sows backycund
— Colors by Sch
£ ORACLE_OCM e
© Create new dataset from a connection or Data Source £ OUTLN Coler scherme () Micebion
= PPM_DWH (CURRENT) | =4 Vosstiors  |Defout
0 o waws T T ) —_— = PPM_JASPERSOFT » Coll borders
Connection £ RODWH_USER i S I —
1 4 )
Please seect e = RO_USER Y | B r. =
¢ m ) Texts| Outline | Diagram R 3
- wed - e He 4 Add Cobumn Header ¢ 234 Gooup Header
voup P Cobumn Fog
Une am ermpty Dt Source \:?/\\ < Back “ Next » J l Finish ] [ Cancel ) T Py
w2 FDstatcurce mpretnoe - . g

Let Rego be your guide. regoUniverSityZOZS
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Basic Report Objects: Table (Cont.)

* Creating a table using the existing dataset uses the already available dataset in the report

0 Table Wizard C=SCo0 ]

Dataset

Please select or build a dataset that will be used for this component.

Create a Table using a new dataset

@) Create a Table using an existing dataset

Table Dataset -
Table Dataset

#) Table Wizard - T e S|

Layout

Table Layout:

* Table layout screen provides you the

Cell Colors Style preview
additional features that you can opt for the table. | ™ 5w o

[T] Use alternated detail rows background

* User can select the Colors for the Header

Color scheme |[J Aliceblue -

Varistions | Default ~|

( Table/Column ) and Detail sections. You can also

ers color Borders style

select different colors for the alternating rows. e

[¥] Add Table Header [¥] Add Column Header [¥] Add Group Header

e User can choose Header/Footer for Tab|e’ [7] Add Group Footer [Z] Add Column Footer  [7] Add Table Footer
Column or Group.

Let Rego be your guide. regoUniverSityZOZS
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Basic Report Objects: Sub Report

* Asub reportis areportincluded inside another report. This allows the creation of very complex layouts
with different portions of a single document filled using different data sources and reports

Here is how you add and configure a sub report:
* Drag the subreport element from Basic element Palette
* You can either create a new report or select an existing report

* Create a new report provides you the option of selecting Report template, appropriate File name, Data
source to use, Connection type and Parameters used for the report

~
a Subreport Report Templates a Subreport

Please select a report from a template
Connection

Subreport
Please specify a report to be used as subreport, or jus S D Please select the connection

© lUse same JDBC connection used to fill the master report:

©) Create a new report Categories
All Use another connection
belectamiew=tngliepott Print Ready Report SP{REPORT_CONNECTION}
Web Interactive Re| . =
Format A4
Format Landscape:
Report Books
U empty Data Sol
Just create the subreport element Blank Ad Blank A4 Landscape
U JRDataso exp
Data Source -
D votrepent T - o
Select a Data Source and design the query.
Cotaset Parameters
V] [ New ]

Data Adapter | CA PPM DWH Dev - Empty rows

This data adapter does not provide any facility to retrieve the fields

* New report will be created upon completion of above steps.

Let Rego be your guide. regoUniversityZOZS
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Basic Report Objects: Sub Report (Cont.)

Subreport

» Select an existing report provides you the option of selecting
already created Jasper report

* Use expression editor to type in the full path of already
created report

Setect a repont file

* Use “Select a report file” to select the Subreport T nemesrence CETSHEREE) 0 Advances
. . Run To Bottom
* Upon selecting the Subreport, choose the Connection Type oveten e =
and Parameters for the sub report and click on Finish to embed === =
the sub report :
Subreport Parameters:
* Common use of a Subreport parameter is to pass the key of a oo paraetens
record printed in the parent report to execute a query in the Subreport Parameters Map.
Subreport. Narne cxpreion | (——
* To pass parameters from the master report to a sub report, e s | SPlemetes)
you create a set of parameter name/object pairs that feed the e Sotemrien
parameters map of the sub report.

* To do this, click the Edit Parameters button on the Subreport
tab of the Properties view to open the Subreport Parameters
dialog. Add in the new Parameter or simply do “Copy from
Master” to copy the parameters from the Main report

Let Rego be your guide. regoUniversityZOZS
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Previewing a Report

* To preview your report inside of Studio you must have a
data adapter set. To run the report, navigate to the report
Design view.

o Blaok Adgoml ., ~ main jremljreml
fity09 v » v - Page 1 of 2,107

e Select the Preview tab on the bottom.

* The report will try to run based on the data adapter set on
the report.

Let Rego be your guide. regoUniverSityZOZS
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Part Ill: Agenda

Advanced Concepts

* Group data on a report
* Modifying the order of data in the report

* Appearance properties overview
 Adding an image to your report
 Adding a dynamic image to your report
* Deploy the report to the server

| n_iversity

DIEGO - 2023

rego



Part |1
Advanced Concepts

v Group details by a field
v’ Modifying the order

v Overview of the appearance properties

regoU-n_iv\ersity

JIEGO - 2023



65

Grouping Data

* Grouping data on a report allows the user to have sections on a report based on a certain field or
parameter.

 Example: A report needs to see all projects under a certain Project Manager. Instead of a line item for each
Investment with the Project Manager on each, it can be grouped.

& Group Band O X

1.Navigate to the Outline Tab. Group

Create a new Group
2.Right click on the Report (This will be the name of the jrxml).
Group Name Group1
(® Create Group from a report object

3.Click the Create Group link. s ey ol
. . Report Objects A
4.Select a field to group the data by or create an expression “INV_NAME
“INV_ID
“DB_ID

which will group the data.

“INV_TYPE

“MANAGER_NAME

“MANAGER_DB_ID

“PRNAME

“PRID v

Next > Finish | Cancel
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Modifying the order the data comes in
can be done in two ways.

1. Order By in the Query
2. Create an Order By Field

To create an Order by Field, navigate to
the Outline tab and right click on the Sort
Fields element. Select the Field you want
to sort on.

In the properties of the sort Field, you
can select if it goes by ascending or
descending.

Exercise: Modify the order of your
report.

New Sort Field

Create a SortField from Field or Variable

Dataset Fields and Variables
“INV_NAME
“INV_ID

“DB_ID

“INV_TYPE
“MANAGER_NAME
“MANAGER _DB_ID
“PRNAME

“'PRID
~PAGE_NUMBER
~COLUMN_NUMBER
~REPORT_COUNT
PAGE_COUNT
~COLUMN_COUNT

Let Rego be your guide.
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Appearance Properties Overview

* The appearance properties can be seen on all objects / elements in the system. It has a generic number of
properties that can be changed to modify the appearance of the object.

* To navigate to the appearance properties, right click on the object and select Show Properties.

Rectan...tangle

Appearance © Borders ~ Rectangle ¥ Inheritance

* Location: Object position on the report layout.

Location

* Size: The size of the object. riion 1y, I
Size
» Stretch Type: Determines how the object should act if a section expands. w10px | 50px
Stretch Type No Stretch
e Color: The font color and background color can be set here. Golor
Forecolor B Backcolor
* Style and Print Details: The style and logic if something should be Ds:::::i:mws
suppressed is stored here.
Style
* Print When: The detail overflow which controls if a field goes over the Z i
allotted space, it can expand itself. The Print When Expression is a Boolean s AT te oo
expression that determines if the object should be visible or not. Smtiron

Print When Expression

Let Rego be your guide. regoUniversityZOZS
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* The user can add images into their reports using the Image object. The image needs to be a local resource stored

in the project to be pulled over.

« Recommended approach is exporting the image into the project explorer and dragging it onto the report. The
reason this is recommended is because the expression will auto fill itself with the location of the image file.

To add an image to your project, follow the steps below.

. Right Click on the Project of the report you want the image to

display on and select Import.

. In the Import Wizard click the File System option to import from.

. Find the Image in your file system.

. Select the image with a checkbox.

. Confirm the Into Folder is your project report folder.

. Click Finish.

. In the Project Explorer drag over the new image to add to the

report.

Let Rego be your guide.

o Import

File system

Import resources from the local file system.

From directory: C\Users\dzlas 000\Pictures
(@] pictures

Filter Types... Select All Deselect All

Into folder: DZ Project Storyboard
Options
[—, Overwrite @usting resources without waming
[[)Create top-level folder
Advanced > >

Browse.
7030767 -3d- background -wallpaperjpg
Elvisjpg
Stanley Shove It Up Your Butt.gif
Thumbs.db
ad_issue.png

Browse..

Finish Cancel
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Adding a Dynamic Image

* By adding an image from project explorer, the expression is automatically filled out with the path of the
image being used. This path however can be changed based on values in the report.
* Two ways to create dynamic images.
* Using an expression based on a field to determine the path of the image.
* Using the print when expression on each image to determine if the image should appear.

* Exercise: Add a checkbox image to the report. Using display only based on a Boolean equation on “Is
Active.”

* Exercise: Based on the days late, show either the green, yellow, or red status indicator from the resource
images.

Let Rego be your guide. regoUniversityZOZS
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Adding an Image to Repository

* If animage is going to be used on multiple reports, such as a logo, or a common status indicator, it is best
practice to put this into a public folder on the repository.

* Using the repository folder to store the image is also the easiest way to determine the expression to find
the image when running the report in Clarity.

* To add the image to the repository and add it to your report, follow the steps below.

1.
2.
3.

N o vk

Navigate to the Repository and click Add Folder. Name it Custom Images.
On the newly created folder, click Add Resource -> File -> Image.
In the Image, upload the image you want the report to reference.
Note: First look at the Clarity images to make sure you can use one of their images first.
Once the Image is in the repository, navigate back to Studio.
In the Repository Explorer, navigate to the Image.
Drag the image onto the report.

Check the Expression. Notice it points towards a “repo” folder. If you tried running this in Studio, it
would fail, but on the report server it will run correctly.

Let Rego be your guide. regoUniversity2023
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Adding an Image as Base64 text

. . .
You can also embed image as Baseb4 text in Jasper report. Following are ke v or cncoingerire s - |

. tz::: g;igﬁzg_;;:TGJ;zp;;s?ft Studio version 6.2.1.final using JasperReports Libra

the adva ntages Of It: ;<ja5perReport xmln;="i.ﬂ:tp:,“,"'jaspe"-‘epc-‘ts‘sou"cefc-‘ge.net,-"jaspe“*epo“ts" xmlns:x

5 <property name="com.jaspersoft.studio.data.sql.tables” value=""/
° N d . . h . 6 ope na E="CCYT.J:aSp cft.studj}c.da?a.defaultdatéadapte”" value="Caltran
eed not save any image In the repository s e L
. Crr.?'aspel‘sc‘fi:.stxjdi.c u‘r\il:.pavng ight’" valuev='_'1n h"/

* Report loads faster and quicker o S AP P o
net.sf.jasperreports.export.xls.detect.cell.type” value="t
pet ot djasperreports pace break no. pacipation™ val pply”/
rg.apache.commons.codec.binary.B 5&64"/>I
e rtaee e —teeeee e ——— >

* To embed image as Base64 text to your report, follow the steps below.
1. Download the image to your desktop. Go to Base 64 encoder

2. Upload the image and click on Encode. Copy the generated
Base64 text to notepad [ Properties 52 - v = o

3. Open the Studio. Import the Base64 package into the report (
Report = Source tab—> Add the tag: <import
value="org.apache.commons.codec.binary.Base64"/> ) I~ Appearance [ Borders ”

<pen lineWidth="0.5" lineColor="#000200"/>
o Vo aifdal WA eB Vi ;1o Waannnanm

Desigll | Source | Rreview

&= Image: Image Search Property e

4. Drag the image element onto the report. Change the image . TP Y
expression as new O
ByteArraylnputStream(newBaseb64().decodeBase64(“<base64text Evaluation Time [ Now -

>”.getBytes("UTF-8")))
<baseb64text> is the generated Base64 text

Let Rego be your guide. regoUniverSityZOZS
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* Deploying a report to a Jaspersoft server is a very seamless and easy
process.

Navigate to the Repository of the Jaspersoft server you want to

1.

2.

kW

deploy the report to.

Next click the Publish Report icon in the top right of the report

next to Settings. ==

=]l :@} & Settings ¥

500 1600 - -1 - - 1766— . 1800 - -1 - -

Navigate to the folder you want to create the report.

Make sure you have the checkbox “Create Report Unit” checked.

Name the report Unit what you would name the report.

Note: The ID is what will be the name of the file when exported

out. Please name appropriately.

. In the Data Source selection, select the data source from

repository.

. Click Finish.

* Exercise: Deploy a report to the environment.

Configure the data source

Select the data source to use

® Data Source from Repository

(O Local Data Source

O Don't use any Data Source

Let Rego be your guide.
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Advanced Concepts
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* Creating your own Input Control
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Parameters and Input Controls

* Input Controls are the way Jaspersoft sends parameters between the

—Jw Rego Consulting
system and the report. They are external from the report.

.. CA PPM
+}.. Ad Hoc Views
+}.. Dashboards

* Parameters are variables on a report that allow the user to filter the
reports data. These are setup on the report itself.

* There are a lot of out of the box input controls created already. Use
these as much as possible.
 Common: Holds the actual Input Control objects
 List of Values: Static Values

e Queries: The queries being used in the Input Controls to populate
the options

* Report Specific: Input Controls used for specific actions in reports.

+w Data Sources

#+ Domains

- Input Controls
+s COmmon
+lu List Of Values
+ Queries

+lw Report Specific

Let Rego be your guide. regoUniversityZOZS
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How to Add an Input Control

* The following steps should be followed to add an input control to a report.

1. Create a parameter in the report. Write down the ID that you give the parameter.
Note: If the input control is from the out of the box selections, make the parameter ID and name the
same as the input control’s ID.

2. Modify the query to accept the parameter either using the filter expression tab or directly in the SQL.

WHERE| ($X{IN, null, c_inv_mgr} OR $X{IN, main_g.manager _id_key, c_inv_mgr})
AND ($X{IN, null, param_project_phase} OR $X{IN, main_g.lkp_project_phase, param_project_phase})
AND ($X{IN, null, c work_status} OR $X{IN, main_g.obj work_status, c work_status})

Resource Editor Input Control

3. Add / create the input control in the Report Unit. ) Mendstoey [ Read Only 1 visible

v = Blank_A4 = MainJrxml Type Multi Select Query
7 Styles Project(s)
v il Parameters Project Manager(s) Query Resource  Value & Visible Columns

O Select from Repository

(®) Local Resource

Exercise: Add an out of the box input control for Project Manager.
Exercise: Adding a custom input control to filter for Is Active and Investment.
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Charts Part 1

* HTML 5 Graphs in Jaspersoft are an element similar to a text field but more complex.

e A user can use the master report’s query as a data source to populate a graph or utilize creating a new
dataset as well.

* The data from the graph can be set to change based on section, page, or even a full report.
To create an HTML 5 Graph, please follow the steps below.

1. Navigate to the Palette.

2. Drag an HTML 5 graph element from the section Components Pro on to the report.

3. Select the type of graph when a dialogue pops up.
Note: This type can be changed at will at anytime.

Let Rego be your guide. regoUniversityZOZS
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Charts Part 2

Part 2 of charts will be going to the Chart Properties and navigating to the data set of the chart.
1. Right click on the Chart and select Edit Chart Properties. Chart Properties tab will appear.

2. The Chart properties allows the user to edit various visual properties of the chart.

3. Click on the tab Data Configuration.
4

. Chart Data allows the user to configure the data and parameters being sent into the chart.

Select Chart Type Data Configuration Chart Formatting

Reset Type: Determines when the chart should refresh it’s
data.

Data Dataset
Reset Type Reset Group

Increment Type: Determines what level the chart data is Page =

being used at. Most commonly use none.

Increment Type Increment Group

None v

Sub Dataset: Determines the data set the chart is using. This  neementeression
can use the main report data set or a sub data set. |

Note: We will create sub data sets in the advanced Sub Dataset  [Report main dataset] v
Jaspersoft class.

Dataset Run

Let Rego be your guide. regoUniversityZOZS
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Charts Part 3 Category Levels

Part 3 of charts will be going over how to populate a Category % Categories level O X
1. On the Data Configuration tab, click the sub tab named Data. Name |
Bucket information Bucket Properties
2. The Categories Levels are the X Axis. You can modify Level 1 or ceoression et
Create your own. Label Expression
3. Click the Add button if you want to create a category or click on Value Class Name | javalang.Comparable  ||..
the category you want to edit and click the Edit button. Order Ascending .
4. In the Name field apply a value for the category. Comparator Expression
Note: Name is just the representation in studio, no affect on the
report' OK Cancel

5. In the Label Expression field, apply the field that will represent
the category name.

6. Depending on the Expression Field’s data type, edit the Value
Class to represent the field type.

7. The Order field orders the categories. This can be set to None if
you are already ordering them within the query.
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Part 4 of charts will be going over how to populate a measure in the chart.
1.
2.

3.

On the Data Configuration tab, click the sub tab named Data.

The Measures are the Y Axis. You can modify Measurel or create your
own.

Click the Add button to make your own or click on the measure you
want to edit and click the Edit Button.
In the Name field apply a value for the category.

Note: Name is just the representation in studio, no affect on the
report.

. In the Label Expression field, apply either a field that will represent the

label of the value, or input a String value of the label. Ex: “Average
Posted Timesheet.”

In the Calculation field, select the calculation to be applied on the
Valued field.

Note: If the data set has already done the calculation, select None. In
the Value Expression, select the field from the data set to be used as
the value for the measure.

In the Value Class name, select the data type that the field selected in
the Value Expression uses.

Let Rego be your guide.

/’) Measure

Name ’ 'MEASURE NAME!

[ | Hidden

Value definition Advanced properties

Label Expression

] "IMEASURE LABEL!"

Calculation Count

Value Expression ’ new Integer(1)

Value Class Name ’java.lang.Number

Increment Factory Class Name’

Associated Hyperlink ! Edit Hyperlink

OK

Cancel
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Surveys

Please take a few moments to fill out the class survey.
Your feedback is extremely important for future events.
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hank You For Attending regoUniversity

Let us know how we can improve!
* Access your account at pmi.org

Instructions for PMI credits I-i’}.

Don’t forget to fill out the class survey.

e Click on Certifications

e Click on Maintain My Certification
* Click on Visit CCR’s button under the Report PDU’s

* Click on Report PDU’s Phone
888.813.0444

* Click on Course or Training
* Class Provider = Rego Consulting

* Class Name = regoUniversity

e Course Description @ Email

« Date Started = Today’s Date info@regoconsulting.com
©]

* Date Completed = Today’s Date
* Hours Completed = 1 PDU per hour of class time

Website

www.regouniversity.com

Let Rego be your guide. regoUniverSity2023
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